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Using This Manual

This is more than just a typical software instruction manual. 

It is an "on-line" User's Manual, providing easy, electronic access to any information you might need 
about DocuPower Pro™. 

You may scan through the manual "normally" (sequentially), the same way you might read any other 
document. But what makes this manual special is the ability to instantly and automatically jump to 
anywhere else in the document. 

Bold green text means jump. You can jump around this manual the same way you jump around 
screens in the Windows "Help" system.

Double-click a green “jump text” chapter title in the Table of Contents to jump directly to that chapter.
At the end of each chapter you can also return to the Table of Contents by double-clicking the jump 
text Double-Click Here To Return To Table Of Contents. Double-click the green cross-references 
throughout the document to jump to a more complete explanation of that topic. (This method for 
jumping around documents was pioneered by Woody Leonhard of PineCliffe International. It's used 
extensively in his great Word for Windows enhancement package, "WOPR" — Woody's Office Power 
Pack.) To enhance the speed of jumping, we recommend that you copy this manual to your hard drive.
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Overview
What is DocuPower Pro™?

After you create Word for Windows documents, how do you find them? You know they're on your 
hard drive, or on the LAN file server... somewhere. If only you could remember the file name, or the 
directory — you might actually be able to get some work done.

DocuPower Pro™ smashes the eight character DOS file name barrier! 

Give long, descriptive names to your documents — up to 45 characters long. DocuPower Pro™ is a 
total document management solution that makes it easy to quickly access your work. On stand-alone 
PC’s as well as across networks, it can completely organize your documents. Best of all, it integrates 
seamlessly into WinWord. 

Check Out These Incredible Features
· Go beyond the eight character DOS file name barrier. With DocuPower Pro™ you can give your documents real, 

meaningful descriptions — up to 45 characters long! 

· Assign enhanced DocuPower Pro™ descriptions while maintaining your original file names. You’ll never misplace a 
file again. Use DocuPower Pro™ descriptions for fast access, or, if you prefer, look at the regular path and file name.

· Get organized — it’s fast and easy. Create an unlimited number of folders for your documents, and give each folder 
its own descriptive title. 

· Each folder holds an unlimited number of document descriptions. Add as many as you like, because they’ll be 
displayed in alphabetical order. Simply touch the keyboard to jump immediately to any part of the list.

· Lightning fast folder list display! See hundreds of files instantly.

· Toggle folder list displays instantly between DocuPower Pro™ document descriptions and DOS file names.

· One file can appear in multiple folders simultaneously. This enables you to organize the same material in different 
ways while avoiding version control problems. 

· Because it’s tightly integrated into WinWord, DocuPower Pro™ will automatically prompt you every time you save 
a new file. So you’re never more than one keystroke or mouse click away from adding your new work directly to a 
folder. 

· Sophisticated folder management allows you to create, rename, or delete entire folders. Plus you can easily move 



documents from one folder to another. 

· Print single or multiple copies of a document directly from any folder — you don’t need to open the file first. 

· Print all documents in a folder with just one command. 

· Fax documents directly from a folder.

· Insert the contents of one document into another. Clicking the “Insert” button lets you perform automated document 
assembly.

· Integrated File Find and Text Search utilities find the files you need fast. Select multiple entries from the list of files 
found. Open all selected files at once, or add all selected files directly to any DocuPower Pro™ folder.

· Integrated file management functions enable you to make directories, copy, rename, delete or move files. The file 
management window is easy and intuitive to use — a dual list box with file names on the left, and your descriptions 
on the right. Do it all without ever leaving WinWord or DocuPower Pro™. 

· Print a detailed folder status report. List document descriptions and file names for all documents in any folder. 

· Free DocuPower Pro Tool Kit includes powerful WinWord macro utilities: Close All Open Files; Display Date On 
Menu; Exit Windows; Restart Windows; List All Files In Directory; Run Program (Command Line); Windows 
System Status.

· Additional tool kits are available to meet specialized needs. The Writer’s Tool Kit includes the following utilities: 
Font Minder, Text Jumper, BookMark Lister, Edit Templates, Open Most Recent Files, Print All Open Files, and 
WinWord INI Changer.

Danger! 
Conventional Document Management Systems 

All document management systems are not alike. DocuPower Pro™ is unique, because we do it all, and
do it safely. To appreciate our revolutionary design, it’s important to understand the dangers of 
conventional document management systems. Those programs also allow you to assign descriptive 
names to your files. However, to keep track of what description goes with which file, they take 
control of your computer. First, they create their own DOS directories for your documents (for 
example C:\MEZ001A2). Next, they rename each file at the DOS level with their own proprietary file 
names, like L000310.DOC. Finally, the new directory structure and proprietary file names are indexed 
and tracked by their database engine.

And that’s the problem with conventional systems — they take too much control away from you. As 
long as your descriptive names are viewed from inside their program, everything is fine. But if you 
want to find a file on your own, you’re out of luck. Just try figuring out what C:\MEZ001A2\
L000310.DOC means!

This can be a real problem. If you need to copy directories or files to a diskette, you’ll be stuck. The 
names that the document management program assigns are totally meaningless to you. So using any 
file management program becomes impractical. Backing up your data also becomes either difficult or 
impossible. How can you back up your documents when you don’t know where they are or what 
they’re named?  

We believe that the benefits offered by these programs are outweighed by the problems that they 
create. It’s just never worth it to give up complete control of your system. 



DocuPower Pro’s Revolutionary Design

Unlike ordinary document management systems, DocuPower Pro™ enhances rather than replaces your
existing directory structure and file names. You’ll always have it both ways. Assign long, descriptive 
names to your documents. Retain your original directory structure and file names. DocuPower Pro™ 
puts you in complete control. 

DocuPower Pro™ gives you the power you need to be in charge of your documents. Try it yourself and
see what it's like to always have your files at your fingertips.

PC's, Networks, and Workgroups

DocuPower Pro™ is designed for use on stand-alone PC’s as well as networks. When installed to a 
network, it can be set up in either individual or workgroup configurations. 

Three basic configurations are available:
1. Stand-alone – for regular PC's which are not connected to a network.
2. Network – for PC's which are part of a network. DocuPower Pro™ folders can contain documents 

from your local drive, as well as files from network drives. Access to network drives is transparent 
to the user. Each user maintains separate folder configurations.

3. Workgroup – for PC's which are part of a network. As above, users can access documents from 
local and network drives. The workgroup version, however, also allows users in the same group to 
access the same set of DocuPower Pro™ folders. By sharing folders and documents, all members 
of the group can benefit from consistent document organization.

The free trial version comes pre-configured for stand-alone and network PC’s. Workgroup licenses for 
any number of users can be purchased by calling us at 800-814-2300 or 718-375-2997. Upon 
payment, you’ll be shipped an installation kit configured for the number of users in your 
workgroup. Please note – volume discount prices are available for site licenses. 

Satisfaction Guaranteed

Rumor has it that Microsoft might be releasing their next version of Word for Windows in the first or 
second quarter of 1994. We guarantee that DocuPower Pro™ will be compatible with future releases of
WinWord. And you can be sure that maintenance upgrades to DocuPower Pro™ will always be 
available to registered users for free. 

Call Today

DocuPower Pro™ costs only $59.95 (hundreds less than other document management systems). Your 
satisfaction is guaranteed. If you aren’t completely happy with DocuPower Pro™, we will promptly 
refund your money. 

Special Offers

· Free software! Buy two, get one free. Combination deal: buy DocuPower Pro™ and a copy of our 
award winning add-in software, Fileware™, at the same time. You'll get a copy of Text Jumper™ 
free! (Text Jumper™ is a hypertext creation and bookmark management utility for Word for 
Windows. It's what we used to write the DocuPower Pro™ manual.) That's a $14.95 value 
absolutely free! It's our gift to you for joining the Total System Solutions family of registered 



software users. 
§ 

· 20% discount! If you purchase the Writer's Tool Kit™ (DocuPower Pro™ Tool Kit #2) together 
with DocuPower Pro™, you'll get $5 off the total price. That's a 20% discount on the Writer's Tool 
Kit! You'll get Font Minder, Text Jumper, BookMark Lister, Edit Templates, Open Most Recent 
Files, Print All Open Files, and WinWord INI Changer. All these powerful WinWord utilities for 
only $19.95 — but only if you order the Writer's Tool Kit at the same time as DocuPower Pro™ 
(regular price $24.95).
§

· Metz Software discount! For a limited time, registered users of DocuPower Pro™ qualify for a 20%
discount on all Metz software products. That includes the award winning Metz Task Manager, as 
well Metz Lock, Metz Phones, and Metz File F/X. (Plus, with every order of Metz Task Manager, 
you'll get a free Metz Task Manager Utility Pack.)

· Upgrade discount! For a limited time, owners of DocuPower 1.x can upgrade to DocuPower Pro™ 
2.0 for a special price. Registered users qualify for the upgrade discount of only $15 per copy (this 
represents an overall savings of 33%).

Act Now!

We accept Visa, MasterCard, American Express and Discover. 
To order, or for more information call toll free 800-814-2300 or 718-375-2997.

§

Acknowledgments
Special thanks to: Wim Morrison for his patience, camaraderie, and C programming talents; Mitchell 
D. Mittman for his unfailing support; Woody Leonhard for his accessibility, encouragement, and for 
paving the way. 

§

Quick Start
Here's how you can get up and running fast! Follow the instructions below to quickly learn how to 
create folders, add your files to them, then easily access them any time. 

Creating Folders & Adding Files
You can create folders and add files fast from the same window.



Mouse
Choose the Add to DocuPower Folder item from the "File" menu

Keyboard
Press Alt+Shift+A

Create A Folder 

Type a title for the folder that you are creating at the flashing cursor (in the empty edit field above the 
list box), then...

Mouse
Click the Create button

Keyboard
Press Enter 
OR press Alt+C 

Now that you've created your first folder, you're ready to add a file to it.

Add a File 

Choose Folder

To add a file to a folder, you have to first open the folder. (For your convenience, the title of a newly 
created folder is already highlighted by default.) So all you have to do is...

Mouse
Click the Open button

Keyboard
Press Enter
OR press Alt+O

Select File

The "Add File" screen that follows contains drive, directory, and file list boxes. Notice that the active 
document (the document which is active on your Word for Windows application workspace) is 
highlighted by default.

Choose a file to add and then...



Mouse
Click the Add button 

Keyboard
Press Enter
OR press Alt+A

Assign Description

In the screen that follows, enter a description for the document you are adding. Make sure that it is no 
longer than the length of the text field, so that the entire document description will be seen in the folder
list box. 

When you are satisfied with the document description you've entered...

Mouse
Click the OK button 

Keyboard
Press Enter

You've just added your first file to a DocuPower Pro™ folder!

§

Accessing Your Files
Once your documents are in folders it's always easy to access them. You can open, insert, print or fax a
document simply by highlighting its description on the folder list and clicking the appropriate button. 

The first step to accessing your files is to open the right folder. 

Opening a Folder

Open the main DocuPower Pro™ window.

Mouse
Choose the Open DocuPower Folders menu item from the "File" menu 

Keyboard
Press Alt+Shift+D

Highlight the folder you want to open, then...



Mouse
Click the Open button 
OR double-click the folder name

Keyboard
Press Enter
OR press Alt+O

Tip
If you find that you have opened the wrong folder, just click the Folders... 
button or press Alt+F to get back to the main screen, where you can choose a
different folder.

§

Action Features

Upon selecting and opening your folder you'll be presented with a new screen. In the center of this 
window will be a list box containing all the document descriptions for that folder. This list box will be 
surrounded by thirteen push-buttons. Highlight the description of the document you want, then...

Opening a Document

To Open a document...



Mouse
Click the Open button 

Keyboard
Press Alt+O
OR press Enter

Tip
Because the Open command is the most commonly used DocuPower Pro™ 
feature, we’ve made it the easiest to use — you can also double click a 
description to open that document in WinWord.

Inserting a Document 

This feature inserts the contents of a file from a DocuPower Pro™ folder into the active  document (the
document which is active in your Word for Windows application workspace). First make sure that your
cursor is positioned where you want to insert the text. 

Highlight the description of the document that you want to insert. Then... 

Mouse
Click the Insert button 

Keyboard
Press Alt+I
OR tab to the Insert button and press Enter

Printing a Document

With DocuPower Pro™, you can print a document right from the folder window, without having to 
open it in WinWord first. To print a document, highlight the desired document description, then...

Mouse
Click the Print / Fax button 

Keyboard
Press Alt+P
OR tab to the Print / Fax button and press Enter

The "Print/Fax" window will appear. This screen is divided into two sections: "Print" and "Fax", each 
of which has its own group box. Choose from selections in the Print group box to print either the 
"Selected document" or "All documents in the folder". Then...



Mouse
Click the OK button 

Keyboard
Press Enter

Faxing A Document

If your system is equipped with a fax board, you can also fax a document without having to open it 
first. To fax a document, highlight the desired document description, then...

Mouse
Click the Print / Fax button

Keyboard
Press Alt+P
OR tab to the Print / Fax button and press Enter

The "Print/Fax" window will appear. Choose the "Selected document" option from the Fax group box. 
Then...

Mouse
Click the OK button

Keyboard
Press Enter

Setting Up Your Fax Board

Before you can send faxes, you'll need to choose a fax driver. This only needs to be done once.

Mouse
Click the Print / Fax button 

Keyboard
Press Alt+P
OR tab to the Print / Fax button and press Enter

In the screen that follows, choose the "Setup fax driver" option from the Fax group box. Then...



Mouse
Click the OK button

Keyboard
Press Enter

Next, highlight the fax driver from the list of available printer drivers. Then...

Mouse
Click the Choose button 

Keyboard
Press Alt+C
OR press Enter

Once your fax driver is set up, DocuPower Pro™ returns you to the Print / Fax window so you can 
immediately send your fax.

§

Running DocuPower Pro™

You can access the various DocuPower Pro™ features in a number of different ways. Commands have 
been conveniently placed on the "File" and "Tools" menus (keyboard shortcuts have also been 
established to assist touch typists).

“File” Menu
The following items are automatically installed onto your "File" menu.



Open DocuPower Pro Folders

Mouse
Select the Open DocuPower Pro Folders menu item from the "File" menu

Keyboard
Press Alt+Shift+D
OR press Alt+F,O

Add to DocuPower Folder  

Mouse
Select the Add to DocuPower Folder item on the "File" menu

Keyboard
Press Alt+Shift+A
OR press Alt+F,A

§

“Tools” Menu 
The following items are automatically installed onto your "Tools" menu. The features below can be 
accessed two ways: from buttons inside the DocuPower Pro™ windows, or directly, via the “Tools” 
menu.

DocuPower Pro – File Find

Select this menu item to run the DocuPower Pro™ File Find module. Even though you've run File Find
directly (from "outside" of the DocuPower Pro™ program), you'll still be able to open the files you 
find, or add them to the DocuPower Pro™ folder of your choice.

DocuPower Pro – Text Search

Select this menu item to run the DocuPower Pro™ Text Search module. Even though you've run Text 
Search directly (from "outside" of the DocuPower Pro™ program), you'll still be able to open the files 
you find, or add them to the DocuPower Pro™ folder of your choice. 

DocuPower Pro – Tool Kit

Select this menu item to run the DocuPower Pro Tool Kit™ macro utilities.



§

HotKey Keyboard Combinations
The following keyboard shortcuts are programmed into WinWord when you install DocuPower Pro™ :

Alt+Shift+D

This key combination will run the main DocuPower Pro™ window (the same as Open DocuPower 
Pro Folders on the "File" menu).

Alt+Shift+A

This key combination will run the Add File To Folder window (the same as Add To DocuPower Pro 
Folder on the "File" menu).

§

Automatic Features
DocuPower Pro™ comes with two replacement macro functions that make it easier for you to open 
DocuPower Pro™ documents, and keep your DocuPower Pro™ folders up-to-date.

File Open

Run the File-Open command as usual:

Mouse
Click the second button on the Tool Bar
OR choose the Open item on the "File" menu

Keyboard
Press Ctrl+F12 
OR press Alt+F,O

The enhanced File Open window that follows has three command buttons: Standard Open, 
DocuPower Open and Cancel.

Standard Open

If the document you want is not already in a DocuPower Pro™ folder, 
you’ll have to open it using the standard WinWord File Open feature. 
(You can then add it to any DocuPower Pro™ folder.)



To open a file using the WinWord File Open function...

Mouse
Click the Standard Open button 

Keyboard
Press S
OR press Enter 

DocuPower Open

If the document you want is already inside a DocuPower Pro™ folder...

Mouse
Click the DocuPower Open button 

Keyboard
Press D 
OR tab to the DocuPower Open button and press 
Enter

This will run the the main DocuPower Pro™ window. Highlight a the 
desired folder, then... 

Mouse
Double click the folder name
OR click the Open button 

Keyboard
Press Alt+O
OR press Enter

Cancel

Choose this option to cancel the File Open operation

File Save 

The DocuPower Pro™ File Save As macro will prompt you to add a file to a DocuPower Pro™ folder 
as soon as you have saved it for the first time. To add a file directly after saving it...

At the prompt: “Add this file to a DocuPower Pro™ folder?” 



Mouse
Click the Yes button 

Keyboard
Press Y
OR press Enter 

§

Managing Your Folders
All the "folder management" functions described below are performed from the main DocuPower 
Pro™ window, which is invoked as follows:

Mouse
Select the Open DocuPower Pro Folders menu item from the "File" menu

Keyboard
Press Alt+Shift+D
OR press Alt+F, O

Selecting A Folder
Once the main DocuPower Pro™ window is displayed you must choose a folder. After a folder is 
selected you can do anything with it: open it, add documents to it, rename it, or delete it. 

Mouse
Use the scroll bars to move the list up and down, then click directly on the 
folder name.

Keyboard
Press the alphanumeric key corresponding to the first character of the folder 
name, then press the down arrow key. The highlighting will jump to the first 
folder name starting with that letter. If the list of folder names is long, you can 
then press the down arrow key until you’ve hilighted the desired folder.

For example, you want to select a folder whose title starts with the letter "M". All you have to do is 
press M, then press the down arrow key. The highlight will jump to the first folder name beginning 
with the letter "M".



After you've highlighted a folder title, you're ready to use the folder management features.

§

Open
Highlight the folder you want to open and then...

Mouse
Click the Open button
OR double-click the folder name

Keyboard
Press Alt+O
OR press Enter

§

Create
Type a title for the folder you wish to create in the empty edit field (at the flashing cursor). Then...

Mouse
Click the Create button

Keyboard
Press Alt+C
OR press Enter 

Hint: if you want to "force" a folder title to appear at the top of the list, begin its title with the asterisk 
(*) symbol.

Tip
Once you’ve created a new folder, its title will be highlighted by default for 
easy opening.

§



Rename
Highlight the folder that you want to rename, then...

Mouse
Click the Rename button 

Keyboard
Press Alt+R
OR tab to the Rename button and press Enter

In the screen that follows, the current folder title will appear, highlighted, in the text box. Edit or 
replace the folder title. When you are satisfied with the new folder title...

Mouse
Click the OK button 

Keyboard
Press Enter

DocuPower Pro™ will return you to the list of folders. 

Tip
Once you’ve renamed a folder, its new title will be highlighted by default for 
easy opening.

§

Delete

What happens when a folder is deleted?

Deleting a folder means that you are deleting the folder title from the list, along with all of the 
document descriptions in that folder. (The actual files associated with these document descriptions 
will not be deleted from your computer or network.) So before you delete a folder, make sure you 
don’t want to keep any of the document descriptions. You might also want to Move some of the 
descriptions into a different folder before deleting. (Alternatively, you could Rename the folder 
instead of deleting it.)

How To Delete A Folder

Highlight the folder you want to delete, then...



Mouse
Click the Delete button 

Keyboard
Press Alt+D
OR tab to the Delete button and press Enter

Confirm the deletion in the message box that follows. When DocuPower Pro™ has deleted the folder, 
it will return you to the updated list of folders

§

Inside Your Folder
Upon selecting and opening a folder you'll be presented with a new screen. In the center of this 
window is a list box containing all the document descriptions for that folder.

Screen Elements
The folder contents window consists of a central list box, with command and option buttons flanking it
on the right and bottom borders of the window. The list box contains an alphabetized list of all of the 
document descriptions in that folder. 

The command buttons on the right side of the window are divided into: Action features (Open, Insert, 
Print / Fax); Management features (Add, Edit, Clear, Move, Status) and the Folders button. 

At the bottom of the window there are two rows of buttons. The top "row" is a set of option buttons 
which control the folder display features. Under this option group is a row of command buttons. The 
first two control the DocuPower Pro™ Search features (File Find, Text Search). The third button 
accesses to the DocuPower Pro™ File Management features.

§

Highlighting a Document Description
The key to using most of the DocuPower Pro™ folder features is to first highlight the description of the
document you want.



Mouse
Use the scroll bars to move the list box up and down, then click directly on the 
description.

Keyboard
Press the alphanumeric key corresponding to the first character of the 
description. The highlighting will jump to the first document description starting
with that letter. Press the down arrow key until the highlight rests on the 
desired document description. If the folder list is very long, you might want to 
use a combination of Page Down and down arrow keys to reach the desired 
document description

For example, to select a document whose description starts with the letter "S", press S. The highlight 
will jump to the first document description beginning with the letter "S".

After you've highlighted a document description, you're ready to use the DocuPower Pro™ folder 
features.

§

Action Features

Open

Highlight the description of the document that you want to open. Then...

Mouse
Click the Open button 

Keyboard
Press Alt+O
OR press Enter

Tip
Because the Open command is the most commonly used DocuPower Pro™ 
feature, we’ve made it the easiest to use — you can also double click a 
description to open a document.

§



Insert

This feature inserts the contents of a file from a DocuPower Pro™ folder into the active  document (the
document which is active in your Word for Windows application workspace). First make sure that your
cursor is positioned where you want to insert the text. 

Highlight the description of the document that you want to insert. Then... 

Mouse
Click the Insert button 

Keyboard
Press Alt+I
OR tab to the Insert button and press Enter

§

Print/Fax

DocuPower Pro™ allows you to print or fax documents directly from the folder window, without 
needing to open them in WinWord first.

Highlight the desired document description, then...

Mouse
Click the Print / Fax button 

Keyboard
Press Alt+P
OR  tab to the Print / Fax button and press Enter 

The "Print/Fax" window will appear. This screen is divided into two sections: "Print" and "Fax", each 
of which has its own group box.

Printing One Document

Choose the "Selected document" option in the "Print" group box. Specify the number of copies to be 
printed (one is the default), then...



Mouse
Click the OK button 

Keyboard
Press Enter

Print All Documents In A Folder

Select the "All documents in the folder" option in the "Print" group box. Specify the number of copies 
of each to be printed, then...

Mouse
Click the OK button 

Keyboard
Press Enter

Setting Up Your Fax Board

To fax a document directly from DocuPower Pro™, you'll need to first set things up by specifying the 
fax driver. This only needs to be done once. To select a driver for your fax board...

Mouse
Click the Print / Fax button 

Keyboard
Press Alt+P
OR tab to the Print / Fax button and press Enter 

The "Print/Fax" window will appear. In the "Fax" group box, select the "Setup fax driver" option and 
then...

Mouse
Click the OK button 

Keyboard
Press Enter

In the screen that follows, select a fax driver from the list of available printer drivers, and then...



Mouse
Click the Choose button 

Keyboard
Press Alt+C
OR press Enter

You’re now able to send faxes from inside DocuPower Pro™ simply by pointing and clicking.

Faxing A Document

Highlight the description of the desired document, then...

Mouse
Click the Print / Fax button 

Keyboard
Press Alt+P
OR  tab to the Print / Fax button and press Enter 

In the Fax group box, choose the "Selected document" option,  then...

Mouse
Click the OK button 

Keyboard
Press Enter

§

Managing Documents 

Add

You can add documents to DocuPower Pro™ from inside any folder. Here’s how...



Mouse
Click the Add button 

Keyboard
Press Enter
OR press Alt+A

Select A File

The "Add File" screen that follows contains drive, directory, and file list boxes. Notice that the active 
document (the document which is active on your Word for Windows application workspace) is 
highlighted by default.

Choose a file to add and then...

Mouse
Click the Add button 

Keyboard
Press Alt+A
OR tab to the Add button and press Enter

Assign Description

In the screen that follows, enter a description for the document you are adding in the text box. Make 
sure that the description is no longer than the length of the edit field, so that the entire document 
description will be seen in the folder list box. 

When you are satisfied with the document description you've entered...

Mouse
Click the OK button 

Keyboard
Press Enter

§

Edit

You can always change the DocuPower Pro™ description associated with a document. (Alternatively, 
you can also specify a new file path for a given description). First, highlight the entry to be edited, 
then...



Mouse
Click the Edit button 

Keyboard
Press Alt+E
OR tab to the Edit button and press Enter

Change A Description

To change a document description, select the Edit Item Description option. Then...

Mouse
Click the OK button 

Keyboard
Press Enter

In the screen that follows, the current document description will appear. Edit or replace the document 
description, making sure that the new document description does not exceed the width of the text entry 
box. 

When you are satisfied with the new document description...

Mouse
Click the OK button 

Keyboard
Press Enter

DocuPower Pro™ will return you to the folder window. The modified entry will be highlighted by 
default.

Modify A File Path

To modify the file path associated with a document description, highlight the entry you want to change
and then...



Mouse
Click the Edit button 

Keyboard
Press Alt+E
OR tab to the Edit button and press Enter

Select the "Modify file path" option and then...

Mouse
Click the OK button 

Keyboard
Press Enter 

In the Modify File screen that follows, select a new file path for the entry. If the current path is still 
valid, it will be highlighted in the drive-directory-file list box. If the current path is not valid, the 
display will default to the Current System Directory. 

Choose a new file path and then...

Mouse
Click the Modify button 

Keyboard
Press Alt+M
OR press Enter

Display Current Information

You can also display detailed information about a document. Highlight an entry, then...

Mouse
Click the Edit button 

Keyboard
Press Alt+E
OR tab to the Edit button and press Enter

In the window that follows, 



Mouse
Double-click the Display Description and File Path button

Keyboard
Press Alt+D
OR tab to the Display Description and File Path button and press Enter

A message box will appear displaying the document description and its current file path.

§

Clear

Clearing an item from a folder means removing its description from the folder list. The actual file is 
not deleted. If you want to delete a file (not just its description) see the File Management section 
below.

To clear an item from a folder, select the entry that you want to remove and then...

Mouse
Click the Clear button 

Keyboard
Press Alt+C
OR tab to the Clear button and press Enter

§

Move

The Move feature allows you reorganize by moving document descriptions between folders. To move 
a document description from one folder to another, highlight the entry you want to move, then...

Mouse
Click the Move button 

Keyboard
Press Alt+M
OR tab to the Move button and press Enter

In the screen that follows, select a destination folder from the list and then...



Mouse  
Click the Choose button 

Keyboard
Press Alt+C
OR press Enter

DocuPower Pro™ will move the document to the destination folder, then re-display the original folder. 

§

The “Status” Button
The Status feature generates folder status reports. Reports currently available include: 

1. A report detailing all folder entries with their document descriptions and file paths
2. A report detailing just those entries whose file paths are invalid. (File paths become invalid when a 

file management utility other than DocuPower Pro™ has been used to rename, move, or delete 
DocuPower Pro™ files).

Mouse
Click the Status button

Keyboards
Press Alt+S
OR tab to the Status button and press Enter

In the screen that follows, you'll be presented with two option buttons.

All Document Descriptions and File Paths

Choose this option to automatically create a WinWord document containing a list of all documents in 
the folder. The list will contain the name of the folder, document descriptions and complete file paths.

To compile a list of information for all folder entries...



Mouse
Double-click the All document descriptions and file paths option button

Keyboard
Press A and then press Enter
OR arrow key down to the All document descriptions and file paths option 
button, and then press Enter

Only Documents With Invalid File Paths

Choose this option to automatically create a WinWord document containing a list of only those 
documents in the folder whose file path statements are no longer valid. The list will contain the name 
of the folder, document descriptions and complete file paths.

To compile a list of only those folder entries whose file paths are no longer valid...

Mouse
Double-click the Only documents with invalid file paths option button

Keyboard
Press O and then press Enter
OR arrow key down to the Only documents with invalid file paths option 
button, and then press Enter

§

The “Folders...” Button
The Folders... button lets you return to the main DocuPower Pro™ window (the list of available 
folders), where you can choose another folder to open.

To return to the main Folders window...



Main
Click the Folders... button 

Keyboard
Press Alt+F
OR tab to the Folders... button and press Enter

§

List box Display Options
DocuPower Pro™ offers you two display options in the folder list box. You can show either document 
descriptions or file paths. These folder display options are controlled by the “Select Display for 
DocuPower Pro Folders” option group (found under the list box).

Document Descriptions (Default Display)

To display the document descriptions...

Mouse
Click the Display Descriptions option button once

Keyboard
Press Alt+D 

File Names

To display the DOS file names of the folder items...

Mouse
Click the Display File Names option button once

Keyboard
Press Alt+L 

§



File Management
DocuPower Pro™ comes with powerful and fully integrated file management functions designed 
especially for use with documents in your DocuPower Pro™ folders. These utilities will manipulate 
your files at the DOS level. You can create new DOS directories, as well as rename, delete, move and 
copy files. If you wish to perform file management functions on documents which are in DocuPower 
Pro™ folders, you must use this integrated utility. Use of any other file management utility will cause 
DocuPower Pro™ to lose the file path information it needs to maintain your folders.

Running File Management 
From the inside of any DocuPower Pro™ folder highlight a document, then...

Mouse
Click the File Management button 

Keyboard
Press Alt+T
OR tab to the File Management button and press Enter

Screen Elements

The main window component is the dual list box. The left hand side contains file names while the right
hand side contains the corresponding document descriptions. Highlighting on the two sides of the list 
box is linked. Select a document description and its file name will also become highlighted. 
Alternatively, select a file name and the corresponding document description will be highlighted. The 
directory path of the selected file appears above the list box near the top of the screen.

Tip
The document which was highlighted in the folder window will also be 
highlighted by default in the file management dual list box. You can also select
a different file from the dual list.

§

Features

Copy File

Highlight a document to copy to another directory, then...



Mouse
Click the Copy File button 

Keyboard
Press Alt+C
OR tab to the Copy File button and press Enter

Notice that the file you highlighted in the file management window will be automatically highlighted 
in the Copy File screen. You can copy this file, or select a different file to copy by highlighting its file 
name. (You can copy any file to and from any location – not just documents from a DocuPower Pro™ 
folder.)

Select a destination drive and directory for the file to be copied. Then...

Mouse
Click the Copy button 

Keyboard
Press Alt+C
OR press Enter

§

Move File

Highlight an item to move and then...

Mouse
Click the Move File button 

Keyboard
Press Alt+M
Tab to the Move File button and click Enter

In the screen that follows, choose a target directory into which to move the file, then...



Mouse
Click the Choose button 

Keyboard
Press Alt+C
OR press Enter

After moving the document, DocuPower Pro™ returns you to the folder window. 

§

Delete File

Delete File actually deletes files from your computer. Use this function with caution! Highlight the 
document you want to delete and then...

Mouse
Click the Delete File button 

Keyboard
Press Alt+D
OR tab to the Delete File button and press Enter

Delete File also automatically removes the document description from the folder list.

§

Rename File

Rename File changes the DOS name of files in DocuPower Pro™ folders. Select the document you 
want to rename, then...

Mouse
Click the Rename File button 

Keyboard
Press Alt+R
OR tab to the Rename File button and press Enter

The current file name appears in the upper portion of the screen. Enter a new file name in the text box 
(be sure to follow standard DOS naming conventions). Then...



Mouse
Click the Rename button 

Keyboard
Press Alt+R
OR press Enter

Tip 
If the file extension that you want is the same as your default WinWord 
document extension (i.e. DOC) you don't need to enter it. Just type in the new 
file name and click the Rename button or press Enter. DocuPower Pro™ will 
append the default extension for you.

§

Make Directory

This feature provides you with the ability to create a real DOS directory. From the File Management 
window...

Mouse
Click the Make Directory button

Keyboard
Press Alt+A
OR tab to the Make Directory button and press Enter

In the screen that follows, choose the directory under which to create a new sub-directory, then...

Mouse
Click the Choose button 

Keyboard
Press Alt+C
OR press Enter

In the next screen, enter a name for the new directory in the text entry box. Be sure to follow DOS 
naming conventions. Then...



Mouse
Click the OK button 

Keyboard
Press Enter

§

File Find and Text Search
DocuPower Pro™ includes two powerful integrated search utilities: File Find and Text Search. Each 
allows you to search for files which have the characteristics that you specify. A successful search will 
compile a list of files that match the specified criteria. You may then choose to either open these files 
in WinWord, or add them directly to a DocuPower Pro™ folder. 

File Find 
Its easy to run File Find. Choose one of two ways: 

From Inside A Folder

Mouse
Click the File Find button 

Keyboard
Press Alt+N
OR tab to the File Find button and press Enter

After the search is complete, you’ll have the option of opening the files found, or adding them to any 
folder you choose.



From The “Tools” Menu

Mouse
Select the DocuPower Pro — File Find menu item

Keyboard
Press Alt+O,F

Performing The Search

In the window that follows, choose the starting directory for the search. The specified directory and all 
of its sub-directories will be searched. Then...

Mouse
Click the Choose button 

Keyboard
Press Alt+C
OR press Enter

In the next screen, enter a file filter for the search. This filter will specify what kinds of files you want 
to be included in the search (DOS wildcards are supported). The default filter displayed will be the 
standard WinWord file extension (i.e. *.DOC). After entering the file filter...

Mouse
Click the OK button 

Keyboard
Press Enter

The File Find utility will then build a list of files that match the specified criteria. To stop the search at 
any time press the Escape key or click the Stop button.

To Run File Find Again Fast 

Type a different file path and filter into the text box at the top of the screen, then...



Mouse
Click the Find button 

Keyboard
Press Alt+F
OR press Enter

§

Text Search 
Its easy to run Text Search. Choose one of two ways: 

From Inside A Folder

Mouse
Click the Text Search button 

Keyboard
Press Alt+X
OR tab to the Text Search button and press Enter

After the search is complete, you’ll have the option of opening the files found, or of adding them to 
any folder you choose.

From The “Tools” Menu

Mouse
Select the DocuPower Pro — Text Search menu item

Keyboard
Press Alt+O,T

Performing The Search

In the window that follows, choose the starting directory for the search. The specified directory and all 
of its sub-directories will be searched. Then...



Mouse
Click the Choose button 

Keyboard
Press Alt+C 
OR press Enter

In the following screen, you’ll need to enter a file filter and text string for the search. The file filter 
will specify what kinds of files you want to be included in the search (DOS wildcards are supported). 
The default filter displayed will be the standard WinWord file extension (i.e. *.DOC). Next, type in the
text string for the search. Enter any text which might be unique to the document(s) that you want to 
find. After entering the information...

Mouse
Click the OK button 

Keyboard
Press Enter

The Text Search utility will then build a list of files that match the specified criteria. To stop the search
at any time press the Escape key or click the Stop button.

To Run Text Search Again Fast 

Type different file path, filter and text string information into the text boxes at the top of the screen, 
then...

Mouse
Click the Find button 

Keyboard
Press Alt+F
OR press Enter

§

Multiple Selection of Found Files
If successful, the File Find and Text Search utilities will compile a list of files that match the specified 
criteria. These files can then be either opened in WinWord, or added to a folder. Select one or more 
documents to open or add using the multiple selection techniques outlined below. 



Mouse

Click And Drag 

Select one list entry with a mouse-click, then drag the mouse pointer up or down to extend the 
selection over several entries.

Shift+Click 

Select one list entry with a mouse-click, then shift+click on another entry: those two items plus all 
entries between them will be selected.

Ctrl+Click

Select one entry with a mouse-click, then ctrl+click on other entries. All the entries clicked will remain
selected.

Keyboard

Spacebar, Shift+Arrow Key

Tab to the files list, then arrow key to the first file you want to select. Press the spacebar to select that 
file. Next, press shift+down arrow or shift+up arrow to select a range of files adjacent to one 
another. (Results are the same as the click and drag method described above.)

§

Opening Found Files
Files found by the File Find or Text Search utilities can then be opened in WinWord. Highlight the 
documents you want to open (use the multiple selection techniques outlined above), then...

Mouse
Click the Open File(s) button 

Keyboard
Press Alt+O
OR tab to the Open File(s) button and press Enter

Note: WinWord’s multiple document interface – MDI – allows up to nine files to be open 
simultaneously.

§



Adding Found Files To A Folder
Files found by the File Find or Text Search utilities can be added directly to any DocuPower Pro™ 
folder. There is no limit to the amount of files you can add at the same time. Highlight the documents 
you want to add (use the multiple selection techniques outlined above), then...

Mouse
Click the Add File(s) button 

Keyboard
Press Alt+A
OR tab to the Add File(s) button and press Enter

Choosing A Folder

In the screen that follows, you’ll be presented with a list of DocuPower Pro™ folders. (If you ran File 
Find or Text Search from inside a DocuPower Pro™ folder, the currently active folder will be 
highlighted by default.) 

Select the folder to which you want to add your files, then...

Mouse
Click the Select button 

Keyboard
Press Enter
OR press Alt+S

Creating A Folder

Alternatively, you could also create a new folder for your files. 

Type a title for the folder that you are creating at the flashing cursor (in the empty edit field above the 
list box), then...

Mouse
Click the Create button

Keyboard
Press Enter 
OR press Alt+C 

Adding The Files

Document descriptions can now be assigned for each of the selected files. A series of windows will 



follow – one per file to be added – so that you can specify a document description for each. Each 
window will display the DOS file name, provide a text entry field for a document description, and give
you the choice of three command buttons: Add to Folder, Skip to Next, and Cancel.

Add to Folder 

Use this button to add the specified document to the folder. Enter a description for the file, then...

Mouse
Click the Add to Folder button 

Keyboard
Press Alt+A 
OR press Enter

Skip to Next

Use this button to bypass adding the currently specified file to the folder. After skipping the current 
choice, the next file (if any) will be presented. In this way, you can continue to add the rest of the 
selected documents.

Mouse
Click the Skip to Next button 

Keyboard
Press Alt+S 
OR tab to the Skip to Next button and press Enter

Cancel

Use this button to end the entire operation.

Mouse
Click the Cancel button 

Keyboard
Press the Escape key

§



DocuPower Pro™ Tool Kit
The DocuPower Pro Tool Kit™ is a powerful and convenient launchpad for additional Word for 
Windows macro utilities. Tool Kit™ #1 includes seven macros. These are provided free with your copy
of DocuPower Pro™. Additional Tool Kits are available, and can be ordered by calling Total System 
Soutions.

For your convenience, you can access the Tool Kit™ two ways: from the main DocuPower Pro™ 
window or from the "Tools" menu. 

What’s In The Tool Kit?
Tool Kit™ #1 is included with DocuPower Pro™ free of charge. It contains the following macro 
utilities...

Close All Open Files

Closes all files open in your Word for Windows application workspace with one command. Choose 
between options that let you "Prompt To Save Each One" or "Close Altogether Now" (closes all 
without saving).

Display Date On Menu 

Displays the date on the Word for Windows menu bar between the “Window” and “Help” menus.

Exit Windows Now!

Lets you exit Windows immediately, with just one command.

List All Files in Directory... 

Creates a WinWord document containing an alphabetical list of all the files in a specified DOS 
directory.

Restart Windows

Is your computer's performance degrading? Maybe the memory is getting clogged up. Run Restart 
Windows to instantly restart Windows (and flush out the memory) with just one command.

Run Program (Command Line)

Run any Windows or DOS application from right inside Word for Windows.

Windows System Status (Metz)

Lets you view or print current information about your system — total free memory, space remaining 
on your hard drive, etc. You can also edit the WIN.INI, SYSTEM.INI, AUTOEXEC.BAT, and 
CONFIG.SYS files from this screen.



§

Running the Tool Kit
It’s easy to run the Tool Kit. Choose one of two ways: 

From The “Tools” Menu

To run the Tool Kit™ from the "Tools" menu...

Mouse
Choose the DocuPower Pro — Tool Kit item from the "Tools" menu

Keyboard
Press Alt+O, K

From The Docupower Pro™ Window

To run the Tool Kit™ from the main DocuPower Pro™ window, first open the main DocuPower Pro™ 
window.

Mouse
Choose the Open DocuPower Folders menu item from the "File" menu 

Keyboard
Press Alt+Shift+D

Next, to access the Tool Kit™ from this screen...

Mouse
Click the Tool Kit button

Keyboard
Press Alt+T
OR tab to the Tool Kit button and press Enter

The Tool Kit Window

The DocuPower Pro™ Tool Kit window has three buttons: Run, Folders, and Cancel.

The Run Button

Use this button to run a Tool Kit™ macro. Highlight the macro that you want to run, then...



Mouse
Click the Run button

Keyboard
Press Alt+R 
OR press Enter

The Folders Button

Use this button to exit the Tool Kit™ window and go to the main DocuPower Pro™ window (which 
displays the list of available folders).

Mouse
Click the Folders button

Keyboard
Press Alt+F
OR tab to the Folders button and press Enter

Cancel

Use this button to exit DocuPower Pro™ completely (and return to your WinWord application 
workspace).

Mouse
Click the Cancel button

Keyboard
Press the Escape key

§

Additional Tool Kits
Additional tool kits are available to meet specialized needs. The Writer’s Tool Kit™ includes the 
following utilities: Font Minder, Text Jumper, BookMark Lister, Edit Templates, Open Most Recent 
Files, Print All Open Files, and WinWord INI Changer. 

Font Minder

WinWord documents have a distressing tendency to “lose” the font settings that you so carefully 



specify, and pick up fonts that you don’t want in your document. Run Font Minder to rid your 
document of unwanted fonts, globally replacing them with the fonts of your choice.

Text Jumper

A hypertext creation utility. Create hypertext cross references, tables of contents, indices, just like in 
the DocuPower Pro™ manual. Perfect for on-line reference manuals, or for helping you keep your 
place as you work on large documents. Make your on-line documents as user-friendly as the Windows 
"Help" system! Stop scrolling line after line, page after page. Just point and click to jump to any part of
a document. Your documents will be easier to understand and fun to read. 

BookMark Lister

Savvy writers use the bookmark feature to their advantage. The only problem is... keeping track of the 
invisible critters. Want to know what text your bookmarks are really marking? Run BookMark Lister 
to get a list of your bookmarks, the text that they cover, and the page(s) on which they appear.

Edit Templates

Edit document templates instantly, even if you don't know which directory they're in. 

Open Most Recent Files

With Open Most Recent Files, you can fire up WinWord at the start of the day... and pick up right 
where you left off the night before. Open all four of the files you last had open, with one command.

Print All Open Files

Save time and effort. Print all open files (up to nine) with one command.

WinWord INI Changer

You can customize the default behavior of WinWord so that it is more efficient, user-friendly and 
“responsive” to your needs. But to tweak performance and enhance features, you’ll first need to be 
familiar with a slew of arcane WIN.INI settings. Don’t risk hand editing your WIN.INI — you could 
damage important settings. The WinWord INI Changer utility provides a safe, simple means for 
customizing some of the most useful INI file settings. 

How To Order

Price

The Writer’s Tool Kit™ costs only $24.95, and is available exclusively from Total System Solutions. 
(A real bargain — if purchased separately, this set of professional macro utilities would cost as much 
as $45.00.) 

Special Offer

For a limited time, you can save 20% when you buy the Writer’s Tool Kit. You’ll get a $5.00 discount 



on these powerful WinWord utilities — but only if you order the Writer's Tool Kit at the same time as 
DocuPower Pro™. 

Call Now!

We accept Visa, Mastercard, American Express and Discover. To order your copy call 800-814-2300, 
or 718-375-2997. Alternatively, you can fax us at 718-375-6261, or send your order to our 
CompuServe e-mail address 70154,2463. Make checks or money orders payable to Total System 
Solutions Inc., and mail to 1530 East 18th Street, Suite 6H, Brooklyn NY 11230.

§

Total System Solutions and You

Tech Support
Registered users can receive 60 minutes FREE telephone technical support. After that, 
you have our lifetime technical support guarantee. Send us your questions via electronic 
mail (e-mail) on either our own BBS or CompuServe, or via fax, or via US mail. We will 
promptly respond in writing, usually within 24 hours.

Here's how to contact us:
· Telephone: 718-375-1261

Sunday-Thursday 9:00 AM – 6:30 PM EST
Friday 9:00 AM – 3:00 PM EST

· FAX: 718-375-6261 
Please send faxes only during these hours:
Sunday-Thursday 9:00 AM – 6:30 PM EST
Friday 9:00 AM – 3:00 PM EST
Fax us a detailed description of the problem.

· CompuServe: E-Mail a detailed description of the 
problem to our CIS address: 70154,2463

§

Beta Testing Program
Are you a computer "whiz"? Do you have ideas about how DocuPower Pro™ could be improved? 
Maybe you can join the Total System Solutions beta-testing team! If approved, you'll receive pre-
release versions of DocuPower Pro™ for free. To sign up, call us at 718-375-1261 (open to registered 
users only).



§

Other Products

Fileware™

Fileware™ is a suite of thirteen file maintenance, document management, and program launching 
utilities which integrate seamlessly into Microsoft Word for Windows 2.x. It provides the many 
commonly requested features that Microsoft "forgot" to include. After auto-installation to the "File" or 
"Tools" menu, the Fileware™ system is never more than a mouse click or keystroke away. Now you 
can do everything you need without ever leaving Word for Windows...

· Forget File Manager. Make directories; delete, rename, copy or move files. 
Because it's integrated into Word, Fileware™ is more convenient and much 
safer. 

· Forget Program Manager. Launch programs instantly with Run Buttons, a 
customizable toolbox of push buttons (or type a command on the convenient 
Quick Run Line).

· Forget eight character DOS file names. Fast Files keeps a customizable list 
of document descriptions close at hand. Just point and click to open the files 
you want.

· Forget complicated directory paths. Directory Jump gives you push-button 
access to the directories you use the most. Just one click jumps you 
anywhere on your PC... or across your network.

· Abolish repetitive keystrokes. Close all open files at the same time with just 
one command. Options include Close Without Saving and Prompt To Save.

· Protect your confidential data. Word Lock provides password protection for 
the complete Word for Windows application (not just certain files).

· Edit document templates instantly, even if you don't know which directory 
they're in. 

· Exit Windows with just one command when you're done working.
Fileware™ is a powerful yet inexpensive suite of utilities. It was chosen one of 

the "48 Best Add In" products by PC Magazine; PC Week says, "...adds a 
good selection of file and program management features that were left out of
Word for Windows." In "Hacker's Guide to Word for Windows" (Addison 
Wesley) Woody Leonhard writes, "...the system that Microsoft 
forgot...makes WinWord stand on its ear."

All this for only $39.95 per copy!

Text Jumper™

Make your on-line documents as user-friendly as the Windows "Help" system! Text Jumper™ lets you 
easily create HyperText in Word for Windows. The handy "Bookmark Lister" utility is also included to
help you painlessly manage your WinWord bookmarks. Stop scrolling line after line, page after page. 
Just point and click to jump to any part of a document. Your documents will be easier to understand 



and fun to read. 

Text Jumper™ is fun and useful. The HyperText jump text in this manual was created using Text 
Jumper™. It's an inexpensive and powerful macro utility.

Only $14.95 per copy!

Please call 800-814-2300 or 718-375-2997 to order.

§

Custom Applications
Word for Windows can do great things! Error: Reference source not found™ is a good example. Ask 
yourself what you really wish computers could do. Then call us. 

Total System Solutions, Inc. creates customized Windows solutions for serious business users. We've 
developed turn-key Word for Windows applications to automate document processing for many major 
corporations. If you work with words or numbers in Windows, we can really help you. 

For example, we recently developed a system to automate the generation of commercial leases for one 
of the largest commercial real estate management companies in the world. The time required for the 
creation of customized leases was cut from over 2 weeks to under 20 minutes per lease!

We can save your company time and money while improving and standardizing the quality of your 
output.

Call us today at 718-375-1261 for more information.

§

Appendices

Current System Directory
The Current System Directory is the default directory which is displayed by Word for Windows. You 
normally see this directory when performing the File Open and File Save operations. Clicking through 
the "Directories" box to change directories will also change the Current System Directory, whether or 
not you actually perform a File Open or File Save. This means that the next time you do a File Open 
or File Save, that's where you'll still be. If you keep your files in more than one directory... you've got 
a lot of clicking ahead of you. 

To make your work easier, DocuPower Pro™ does not change the Current System Directory. Under 
certain circumstances DocuPower Pro™ will use Current System Directory information to establish a 
default directory.

1. In general, when adding a document to a DocuPower Pro™ folder, the active document and its 



drive and directory will be highlighted as the default file displayed when you click the Add 
button. However, if (1) the active document has not yet been named and saved; or (2) there is no 
file open; or (3) the active document is a macro —  the Current System Directory is highlighted 
instead.

2. In general, when modifying the path of a DocuPower Pro™ document, the file path and DOS 
name for that document will be highlighted by default when you click the Edit button and choose
the Modify File Path option. However if the document’s current file path is invalid, the Drive-
Directory-File window will display the Current System Directory instead. (File path settings 
become invalid when a file management utility other than DocuPower Pro™ has been used to 
rename, move, or delete DocuPower Pro™ files).

Default Extension
Extensions are the characters (0-3) that appear after the period in the DOS file name. The default 
extension is the set of characters that WinWord automatically appends when you name a file, or uses as
a filter in the File Open screen. Advanced users can change the default extension by modifying an 
entry in the WIN.INI. WinWord ships with a default extension of "*.DOC".

One of DocuPower Pro ‘s “hidden features” is its responsiveness to changes in the default document 
extension. DocuPower Pro™ uses document filters to filter the file lists of the Add and Edit windows, 
as well as in the search criteria for the File Find and Text Search modules. If you have changed the 
default document extension in the WIN.INI, then the new default extension that you have specified 
will be reflected by DocuPower Pro™, as follows:

1. In general, DocuPower Pro™ will filter the file list or search for files by using the default 
extension. If the active document (the document which is active on your Word for Windows 
application workspace) has an extension which is the same as the default extension, then 
DocuPower Pro™ will also use the default extension as the file filter.

2. If the active document has an extension that is different than the default extension, DocuPower 
Pro™ will use *.* as the document filter, enabling you to see all the different kinds of files which 
are available.

Document Status Information
Unlike ordinary document management systems, DocuPower Pro™ enhances rather than replaces your
existing directory structure and file names. DocuPower Pro™ also includes a number of utilities to help
you easily and quickly determine the DOS file names of your DocuPower Pro™ documents. Inside 
each DocuPower Pro™ folder, the “Display” option button set, the Edit Button, and the Status Button 
will help you keep “in touch” with the DOS side of your DocuPower Pro™ documents.

The Display Option Buttons

The DocuPower Pro™ Display features give you a quick look at the file path and document description
information for all of the files in a folder at once. Simply click the option buttons positioned under the 
folder list box.



Tip
When you change the display to file paths, the alphabetical order 
of the documents will be determined by the file paths, not 
document descriptions. But a highlighted document will retain its 
highlighting even when you change the display option. So before 
changing the display option, highlight the entry whose file path you
would like to see. 

The Edit Button

Click the Edit button and you’ll see the Display Description and File Path button. Click this button 
and a message box will appear stating the highlighted entry's document description and current file 
path. 

The Status Button

The Status feature generates folder status reports. These reports detail document information about all 
of the documents in a folder. Reports currently available include: 

1. A report detailing all folder entries with their document descriptions and file paths
2. A report detailing just those entries whose file paths are invalid.
Invalid File Path Message
The document information features listed above will sometimes indicate that a document’s current file 
path is no longer valid. Invalid file paths occur when you use a  file management system other than the 
one included with DocuPower Pro™ to rename, delete, or move a DocuPower Pro™ file at the DOS 
level. These systems fail to "inform" DocuPower Pro™ when they have made a change to the file path 
of a DocuPower Pro™ document. The next time you’ll try to access the file, DocuPower Pro™ will 
display the invalid file path message, and suggest you modify the file path specified for that document.

Shortcuts – Tips & Tricks

Main DocuPower Pro Window 

1. To jump to a folder on the list immediately — press the first alpha-numeric letter of its title and 
then the down arrow.

2. After you’ve renamed or created a folder, the folder that you renamed or created will be the default
highlighted on the list.

DocuPower Pro Documents

1. The document which was highlighted in the folder window will also be highlighted by default in 
the file management dual list box. You can save time by highlighting a document in the folder 
window before you click the File Management button. (You can also select a different file from 
the dual list.)

2. The active document (the document which is active on your Word for Windows application 



workspace) is automatically highlighted in the “Add Item to Folder” window. So one way to 
simplify adding a document to a DocuPower Pro™ folder is to open it first. Make sure that it is the 
active document, then choose the Add To DocuPower Pro Folder item on the “File” menu. When
you reach the “Add Item to Folder” window, the document that you want to add will already be 
highlighted for you.

Drive-Directory-File Windows

1. A quick way to change directories is to type the directory path "\ [directory path] \" in the directory
combo box and press Enter. Be sure to put the backslash character "\" before and after the 
directory name. That directory will appear in the directory box, and its files will show in the file 
box.

2. To go to the root directory, type "\" in the directory combo box and press Enter.

3. To re-filter a file list, type a new file specification in the file combo box (for example, *.BAK) then
press Enter.

4. Confused about where you are in the directory tree? A path statement of the system directory 
appears (in concatenated form) above the directory list box.

5. Change directories in the directory box by double-clicking: double-click on the [..] symbol to move
up a level in the directory tree; double-click on a directory name to move down a level.

Legal Notices

Error: Reference source not found Pro™
Copyright © 1992-93 by Total System Solutions, Inc. 
All rights reserved.
Error: Reference source not found™ 2.0 consists of the main interface and all of its component macro applications and 
libraries.
Error: Reference source not found™ and all its components are copyrighted to Total System Solutions, Inc. All rights 
reserved. For information on purchasing copies of Error: Reference source not found™ for single-user, 
network, or workgroup configurations, please call Total System Solutions at 800-814-2300 or 718-
375-2997. Volume discounts are available for site licenses of multiple copies.

Software License
Error: Reference source not found™ is not public domain software, nor is it free software. The use of Error: Reference 
source not found™, except in demo form (free trial) for the 30-day trial period, requires registration. 
Non-licensed users are granted a limited license to use the demo version of Error: Reference source not
found™ on a 30-day trial basis for the purpose of determining whether Error: Reference source not 
found™ is suitable for their needs. The use of Error: Reference source not found™ even in demo form, 
except for the initial 30-day trial period, requires registration. The use of unlicensed copies of Error: 
Reference source not found™, demo or non-demo versions, outside of the initial 30-day trial period, by 
any person, business, corporation, government agency or any other entity is strictly prohibited. 

A single user license permits a user to use Error: Reference source not found™ only on a single 
computer. Licensed users may use the program on different computers, but may not use the program 
on more than one computer at the same time. A site license permits a company with multiple users to 



use several copies of Error: Reference source not found™ on stand-alone computers, or to use a single 
copy of Error: Reference source not found™ over a network. Site licenses must be arranged for 
individually with Total System Solutions, Inc. No one may modify or patch the Error: Reference 
source not found™ code in any way, including but not limited to de-encrypting, disassembling, or 
otherwise reverse-engineering the program. 

A limited license is granted to copy and distribute demo (free trial) version copies of Error: Reference 
source not found™ only for the 30-day trial use of others, subject to the above limitations, and also the 
following: 

1. Error: Reference source not found™ must be copied in unmodified form, and the demo version only
may be copied. Users with registered copies of Error: Reference source not found™ may not copy 
their installed version of the program for the use of others, even on a trial basis.

2. The full machine-readable Error: Reference source not found™ package, including the files: 
DESC.SDI, DP2_RLS.TXT, FILE_ID.DIZ, FREE.TXT, FWDLG.DLL, INSTALL.DOC, 
MANUAL.DOC, METZ2.DLL, METZCORE.DLL, METZDEAL.TXT, METZHOOK.DLL, 
METZOMEM.DLL, NETWORK.TXT, ORDER.DOC, PACKLIST.TXT, README.TXT, 
SERVICES.TXT, TSS2.DLL, TOOLKIT2.TXT, UPGRADE.DOC, complete with this license 
information must be included with program package copy. 

3. Demo versions of Error: Reference source not found™ may not be distributed in conjunction with 
any other product without a specific license to do so from Total System Solutions, Inc. Distribution
of non-demo versions of Error: Reference source not found™ is strictly forbidden.

4. No fee, charge, or other compensation may be requested or accepted, except as authorized below:

a. Operators of electronic bulletin board systems (sysops) may make demo versions of Error: 
Reference source not found™ available for downloading only as long as the above conditions 
are met. An overall or time-dependent charge for the use of the bulletin board system is 
permitted as long as there is not a specific charge for the download of Error: Reference source 
not found™.

b. Vendors of user-supported or shareware software may distribute demo versions of Error: 
Reference source not found™, subject to the above conditions, without specific permission. 
Vendors may charge a disk duplication fee, which may not exceed five dollars per disk.

c. Non-profit user groups may distribute copies of the Error: Reference source not found™ demo 
diskette to their members, subject to the above conditions; additionally, Total System Solutions 
Inc. must be notified of this distribution. 

Limited Warranty

Total System Solutions, Inc. guarantees your satisfaction with this product. We're so sure you'll love
it that we will refund the purchase price (excluding shipping and handling) for a period of  30 days 
from the date of original purchase. If you are unsatisfied with Error: Reference source not found™ 
at any time within that period, please contact us for a refund.

Total System Solutions, Inc. warrants that the program will perform in substantial compliance with the 
documentation supplied with the software product. If a significant defect in the product is found, the 
Purchaser may return the product for a refund. In no event will such a refund exceed the purchase price
of the product.

EXCEPT AS PROVIDED ABOVE, TOTAL SYSTEM SOLUTIONS, INC. DISCLAIMS ALL 
WARRANTIES, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO 



IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE, WITH RESPECT TO THE PRODUCT. SHOULD THE PROGRAM PROVE 
DEFECTIVE, THE PURCHASER ASSUMES THE RISK OF PAYING THE ENTIRE COST 
OF ALL NECESSARY SERVICING, REPAIR, OR CORRECTION AND ANY INCIDENTAL 
OR CONSEQUENTIAL DAMAGES. IN NO EVENT WILL TOTAL SYSTEM SOLUTIONS, 
INC. BE LIABLE FOR ANY DAMAGES WHATSOEVER (INCLUDING WITHOUT 
LIMITATION DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS 
INTERRUPTION, LOSS OF BUSINESS INFORMATION AND THE LIKE) ARISING OUT 
OF THE USE OR THE INABILITY TO USE THIS PRODUCT EVEN IF TOTAL SYSTEM 
SOLUTIONS, INC. HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

Use of this product for any period of time constitutes your acceptance of this agreement and subjects 
you to its contents.

U.S. Government Restricted Rights

Use, duplication, or disclosure by the Government is subject to restrictions as set forth in subdivision
(b)(3)(ii) of the Rights in Technical Data and Computer Software clause at 252.227-7013. 
Contractor/manufacturer is Total System Solutions, Inc. 1530 East 18th Street, Suite 6H, Brooklyn 
NY 11230.

Trademarks

Microsoft and MS-DOS are registered trademarks of Microsoft Corporation. Windows 3.0 and 
Windows 3.1 are registered trademarks of Microsoft Corporation. Word for Windows is a registered 
trademark of Microsoft Corporation. Error: Reference source not found™, Fileware™ and Text 
Jumper™ are trademarks of Total System Solutions, Inc. 

§

Get the power with DocuPower Pro™ 
“And never misplace a file again!”


	Using This Manual
	Table of Contents
	Overview
	§ Error: Reference source not found
	§ Error: Reference source not found
	§ Error: Reference source not found
	Quick Start

	§ Error: Reference source not found
	§ Error: Reference source not found
	§ Error: Reference source not found
	§ Error: Reference source not found
	Running DocuPower Pro

	§ Error: Reference source not found
	§ Error: Reference source not found
	§ Error: Reference source not found
	§ Error: Reference source not found
	§ Error: Reference source not found
	Managing Your Folders

	§ Error: Reference source not found
	§ Error: Reference source not found
	§ Error: Reference source not found
	§ Error: Reference source not found
	§ Error: Reference source not found
	§ Error: Reference source not found
	Inside Your Folder

	§ Error: Reference source not found
	§ Error: Reference source not found
	§ Error: Reference source not found
	§ Error: Reference source not found
	§ Error: Reference source not found
	§ Error: Reference source not found
	§ Error: Reference source not found
	§ Error: Reference source not found
	§ Error: Reference source not found
	§ Error: Reference source not found
	§ Error: Reference source not found
	§ Error: Reference source not found
	§ Error: Reference source not found
	File Management

	§ Error: Reference source not found
	§ Error: Reference source not found
	§ Error: Reference source not found
	§ Error: Reference source not found
	§ Error: Reference source not found
	§ Error: Reference source not found
	§ Error: Reference source not found
	File Find And Text Search

	§ Error: Reference source not found
	§ Error: Reference source not found
	§ Error: Reference source not found
	§ Error: Reference source not found
	§ Error: Reference source not found
	§ Error: Reference source not found
	DocuPower Pro Tool Kit

	§ Error: Reference source not found
	§ Error: Reference source not found
	§ Error: Reference source not found
	§ Error: Reference source not found
	Total System Solutions and You

	§ Error: Reference source not found
	§ Error: Reference source not found
	§ Error: Reference source not found
	§ Error: Reference source not found
	Appendices

	§ Error: Reference source not found
	§ Error: Reference source not found
	§ Error: Reference source not found
	§ Error: Reference source not found
	§ Error: Reference source not found

	Overview
	What is DocuPower Pro™?
	Check Out These Incredible Features
	· Go beyond the eight character DOS file name barrier. With DocuPower Pro™ you can give your documents real, meaningful descriptions — up to 45 characters long!
	· Assign enhanced DocuPower Pro™ descriptions while maintaining your original file names. You’ll never misplace a file again. Use DocuPower Pro™ descriptions for fast access, or, if you prefer, look at the regular path and file name.
	· Get organized — it’s fast and easy. Create an unlimited number of folders for your documents, and give each folder its own descriptive title.
	· Each folder holds an unlimited number of document descriptions. Add as many as you like, because they’ll be displayed in alphabetical order. Simply touch the keyboard to jump immediately to any part of the list.
	· Lightning fast folder list display! See hundreds of files instantly.
	· Toggle folder list displays instantly between DocuPower Pro™ document descriptions and DOS file names.
	· One file can appear in multiple folders simultaneously. This enables you to organize the same material in different ways while avoiding version control problems.
	· Because it’s tightly integrated into WinWord, DocuPower Pro™ will automatically prompt you every time you save a new file. So you’re never more than one keystroke or mouse click away from adding your new work directly to a folder.
	· Sophisticated folder management allows you to create, rename, or delete entire folders. Plus you can easily move documents from one folder to another.
	· Print single or multiple copies of a document directly from any folder — you don’t need to open the file first.
	· Print all documents in a folder with just one command.
	· Fax documents directly from a folder.
	· Insert the contents of one document into another. Clicking the “Insert” button lets you perform automated document assembly.
	· Integrated File Find and Text Search utilities find the files you need fast. Select multiple entries from the list of files found. Open all selected files at once, or add all selected files directly to any DocuPower Pro™ folder.
	· Integrated file management functions enable you to make directories, copy, rename, delete or move files. The file management window is easy and intuitive to use — a dual list box with file names on the left, and your descriptions on the right. Do it all without ever leaving WinWord or DocuPower Pro™.
	· Print a detailed folder status report. List document descriptions and file names for all documents in any folder.
	· Free DocuPower Pro Tool Kit includes powerful WinWord macro utilities: Close All Open Files; Display Date On Menu; Exit Windows; Restart Windows; List All Files In Directory; Run Program (Command Line); Windows System Status.
	· Additional tool kits are available to meet specialized needs. The Writer’s Tool Kit includes the following utilities: Font Minder, Text Jumper, BookMark Lister, Edit Templates, Open Most Recent Files, Print All Open Files, and WinWord INI Changer.
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	Quick Start
	Creating Folders & Adding Files
	Mouse
	Choose the Add to DocuPower Folder item from the "File" menu

	Keyboard
	Press Alt+Shift+A

	Create A Folder
	Mouse
	Click the Create button

	Keyboard
	Press Enter
	OR press Alt+C


	Add a File
	Choose Folder
	Mouse
	Click the Open button

	Keyboard
	Press Enter
	OR press Alt+O


	Select File
	Mouse
	Click the Add button

	Keyboard
	Press Enter
	OR press Alt+A


	Assign Description
	Mouse
	Click the OK button

	Keyboard
	Press Enter




	Accessing Your Files
	Opening a Folder
	Mouse
	Choose the Open DocuPower Folders menu item from the "File" menu

	Keyboard
	Press Alt+Shift+D

	Mouse
	Click the Open button
	OR double-click the folder name

	Keyboard
	Press Enter
	OR press Alt+O

	Tip
	If you find that you have opened the wrong folder, just click the Folders... button or press Alt+F to get back to the main screen, where you can choose a different folder.


	Action Features
	Opening a Document
	Mouse
	Click the Open button

	Keyboard
	Press Alt+O
	OR press Enter


	Tip
	Because the Open command is the most commonly used DocuPower Pro™ feature, we’ve made it the easiest to use — you can also double click a description to open that document in WinWord.

	Inserting a Document
	Mouse
	Click the Insert button

	Keyboard
	Press Alt+I
	OR tab to the Insert button and press Enter


	Printing a Document
	Mouse
	Click the Print / Fax button

	Keyboard
	Press Alt+P
	OR tab to the Print / Fax button and press Enter

	Mouse
	Click the OK button

	Keyboard
	Press Enter


	Faxing A Document
	Mouse
	Click the Print / Fax button

	Keyboard
	Press Alt+P
	OR tab to the Print / Fax button and press Enter

	Mouse
	Click the OK button

	Keyboard
	Press Enter


	Setting Up Your Fax Board
	Mouse
	Click the Print / Fax button

	Keyboard
	Press Alt+P
	OR tab to the Print / Fax button and press Enter

	Mouse
	Click the OK button

	Keyboard
	Press Enter

	Mouse
	Click the Choose button

	Keyboard
	Press Alt+C
	OR press Enter





	Running DocuPower Pro™
	“File” Menu
	Open DocuPower Pro Folders
	Mouse
	Select the Open DocuPower Pro Folders menu item from the "File" menu

	Keyboard
	Press Alt+Shift+D
	OR press Alt+F,O


	Add to DocuPower Folder
	Mouse
	Select the Add to DocuPower Folder item on the "File" menu

	Keyboard
	Press Alt+Shift+A
	OR press Alt+F,A



	“Tools” Menu
	DocuPower Pro – File Find
	DocuPower Pro – Text Search
	DocuPower Pro – Tool Kit

	HotKey Keyboard Combinations
	Alt+Shift+D
	Alt+Shift+A

	Automatic Features
	File Open
	Mouse
	Click the second button on the Tool Bar
	OR choose the Open item on the "File" menu

	Keyboard
	Press Ctrl+F12
	OR press Alt+F,O

	Standard Open
	Mouse
	Click the Standard Open button

	Keyboard
	Press S
	OR press Enter


	DocuPower Open
	Mouse
	Click the DocuPower Open button

	Keyboard
	Press D
	OR tab to the DocuPower Open button and press Enter

	Mouse
	Double click the folder name OR click the Open button

	Keyboard
	Press Alt+O
	OR press Enter


	Cancel

	File Save
	Mouse
	Click the Yes button

	Keyboard
	Press Y
	OR press Enter




	Managing Your Folders
	Mouse
	Select the Open DocuPower Pro Folders menu item from the "File" menu

	Keyboard
	Press Alt+Shift+D
	OR press Alt+F, O

	Selecting A Folder
	Mouse
	Use the scroll bars to move the list up and down, then click directly on the folder name.

	Keyboard
	Press the alphanumeric key corresponding to the first character of the folder name, then press the down arrow key. The highlighting will jump to the first folder name starting with that letter. If the list of folder names is long, you can then press the down arrow key until you’ve hilighted the desired folder.


	Open
	Mouse
	Click the Open button OR double-click the folder name

	Keyboard
	Press Alt+O
	OR press Enter


	Create
	Mouse
	Click the Create button

	Keyboard
	Press Alt+C
	OR press Enter

	Tip
	Once you’ve created a new folder, its title will be highlighted by default for easy opening.


	Rename
	Mouse
	Click the Rename button

	Keyboard
	Press Alt+R
	OR tab to the Rename button and press Enter

	Mouse
	Click the OK button

	Keyboard
	Press Enter

	Tip
	Once you’ve renamed a folder, its new title will be highlighted by default for easy opening.


	Delete
	What happens when a folder is deleted?
	How To Delete A Folder
	Mouse
	Click the Delete button

	Keyboard
	Press Alt+D
	OR tab to the Delete button and press Enter




	Inside Your Folder
	Screen Elements
	Highlighting a Document Description
	Mouse
	Use the scroll bars to move the list box up and down, then click directly on the description.

	Keyboard
	Press the alphanumeric key corresponding to the first character of the description. The highlighting will jump to the first document description starting with that letter. Press the down arrow key until the highlight rests on the desired document description. If the folder list is very long, you might want to use a combination of Page Down and down arrow keys to reach the desired document description


	Action Features
	Open
	Mouse
	Click the Open button

	Keyboard
	Press Alt+O
	OR press Enter

	Tip
	Because the Open command is the most commonly used DocuPower Pro™ feature, we’ve made it the easiest to use — you can also double click a description to open a document.


	Insert
	Mouse
	Click the Insert button

	Keyboard
	Press Alt+I
	OR tab to the Insert button and press Enter


	Print/Fax
	Mouse
	Click the Print / Fax button

	Keyboard
	Press Alt+P
	OR tab to the Print / Fax button and press Enter

	Printing One Document
	Mouse
	Click the OK button

	Keyboard
	Press Enter


	Print All Documents In A Folder
	Mouse
	Click the OK button

	Keyboard
	Press Enter


	Setting Up Your Fax Board
	Mouse
	Click the Print / Fax button

	Keyboard
	Press Alt+P
	OR tab to the Print / Fax button and press Enter

	Mouse
	Click the OK button

	Keyboard
	Press Enter

	Mouse
	Click the Choose button

	Keyboard
	Press Alt+C
	OR press Enter


	Faxing A Document
	Mouse
	Click the Print / Fax button

	Keyboard
	Press Alt+P
	OR tab to the Print / Fax button and press Enter

	Mouse
	Click the OK button

	Keyboard
	Press Enter




	Managing Documents
	Add
	Mouse
	Click the Add button

	Keyboard
	Press Enter
	OR press Alt+A

	Select A File
	Mouse
	Click the Add button

	Keyboard
	Press Alt+A OR tab to the Add button and press Enter


	Assign Description
	Mouse
	Click the OK button

	Keyboard
	Press Enter



	Edit
	Mouse
	Click the Edit button

	Keyboard
	Press Alt+E
	OR tab to the Edit button and press Enter

	Change A Description
	Mouse
	Click the OK button

	Keyboard
	Press Enter

	Mouse
	Click the OK button

	Keyboard
	Press Enter


	Modify A File Path
	Mouse
	Click the Edit button

	Keyboard
	Press Alt+E
	OR tab to the Edit button and press Enter

	Mouse
	Click the OK button

	Keyboard
	Press Enter

	Mouse
	Click the Modify button

	Keyboard
	Press Alt+M
	OR press Enter


	Display Current Information
	Mouse
	Click the Edit button

	Keyboard
	Press Alt+E
	OR tab to the Edit button and press Enter

	Mouse
	Double-click the Display Description and File Path button

	Keyboard
	Press Alt+D
	OR tab to the Display Description and File Path button and press Enter



	Clear
	Mouse
	Click the Clear button

	Keyboard
	Press Alt+C
	OR tab to the Clear button and press Enter


	Move
	Mouse
	Click the Move button

	Keyboard
	Press Alt+M
	OR tab to the Move button and press Enter

	Mouse
	Click the Choose button

	Keyboard
	Press Alt+C
	OR press Enter



	The “Status” Button
	Mouse
	Click the Status button

	Keyboards
	Press Alt+S
	OR tab to the Status button and press Enter

	All Document Descriptions and File Paths
	Mouse
	Double-click the All document descriptions and file paths option button

	Keyboard
	Press A and then press Enter
	OR arrow key down to the All document descriptions and file paths option button, and then press Enter


	Only Documents With Invalid File Paths
	Mouse
	Double-click the Only documents with invalid file paths option button

	Keyboard
	Press O and then press Enter
	OR arrow key down to the Only documents with invalid file paths option button, and then press Enter



	The “Folders...” Button
	Main
	Click the Folders... button

	Keyboard
	Press Alt+F
	OR tab to the Folders... button and press Enter


	List box Display Options
	Document Descriptions (Default Display)
	Mouse
	Click the Display Descriptions option button once

	Keyboard
	Press Alt+D


	File Names
	Mouse
	Click the Display File Names option button once

	Keyboard
	Press Alt+L




	File Management
	Running File Management
	Mouse
	Click the File Management button

	Keyboard
	Press Alt+T
	OR tab to the File Management button and press Enter

	Screen Elements
	Tip
	The document which was highlighted in the folder window will also be highlighted by default in the file management dual list box. You can also select a different file from the dual list.



	Features
	Copy File
	Mouse
	Click the Copy File button

	Keyboard
	Press Alt+C
	OR tab to the Copy File button and press Enter

	Mouse
	Click the Copy button

	Keyboard
	Press Alt+C
	OR press Enter


	Move File
	Mouse
	Click the Move File button

	Keyboard
	Press Alt+M
	Tab to the Move File button and click Enter

	Mouse
	Click the Choose button

	Keyboard
	Press Alt+C
	OR press Enter


	Delete File
	Mouse
	Click the Delete File button

	Keyboard
	Press Alt+D
	OR tab to the Delete File button and press Enter


	Rename File
	Mouse
	Click the Rename File button

	Keyboard
	Press Alt+R
	OR tab to the Rename File button and press Enter

	Mouse
	Click the Rename button

	Keyboard
	Press Alt+R
	OR press Enter

	Tip
	If the file extension that you want is the same as your default WinWord document extension (i.e. DOC) you don't need to enter it. Just type in the new file name and click the Rename button or press Enter. DocuPower Pro™ will append the default extension for you.


	Make Directory
	Mouse
	Click the Make Directory button

	Keyboard
	Press Alt+A
	OR tab to the Make Directory button and press Enter

	Mouse
	Click the Choose button

	Keyboard
	Press Alt+C
	OR press Enter

	Mouse
	Click the OK button

	Keyboard
	Press Enter




	File Find and Text Search
	File Find
	From Inside A Folder
	Mouse
	Click the File Find button

	Keyboard
	Press Alt+N
	OR tab to the File Find button and press Enter


	From The “Tools” Menu
	Mouse
	Select the DocuPower Pro — File Find menu item

	Keyboard
	Press Alt+O,F

	Performing The Search
	Mouse
	Click the Choose button

	Keyboard
	Press Alt+C
	OR press Enter

	Mouse
	Click the OK button

	Keyboard
	Press Enter


	To Run File Find Again Fast
	Mouse
	Click the Find button

	Keyboard
	Press Alt+F
	OR press Enter




	Text Search
	From Inside A Folder
	Mouse
	Click the Text Search button

	Keyboard
	Press Alt+X
	OR tab to the Text Search button and press Enter


	From The “Tools” Menu
	Mouse
	Select the DocuPower Pro — Text Search menu item

	Keyboard
	Press Alt+O,T

	Performing The Search
	Mouse
	Click the Choose button

	Keyboard
	Press Alt+C
	OR press Enter

	Mouse
	Click the OK button

	Keyboard
	Press Enter


	To Run Text Search Again Fast
	Mouse
	Click the Find button

	Keyboard
	Press Alt+F
	OR press Enter




	Multiple Selection of Found Files
	Mouse
	Click And Drag
	Shift+Click
	Ctrl+Click

	Keyboard
	Spacebar, Shift+Arrow Key


	Opening Found Files
	Mouse
	Click the Open File(s) button

	Keyboard
	Press Alt+O
	OR tab to the Open File(s) button and press Enter


	Adding Found Files To A Folder
	Mouse
	Click the Add File(s) button

	Keyboard
	Press Alt+A
	OR tab to the Add File(s) button and press Enter

	Choosing A Folder
	Mouse
	Click the Select button

	Keyboard
	Press Enter
	OR press Alt+S


	Creating A Folder
	Mouse
	Click the Create button

	Keyboard
	Press Enter
	OR press Alt+C


	Adding The Files
	Add to Folder
	Mouse
	Click the Add to Folder button

	Keyboard
	Press Alt+A
	OR press Enter


	Skip to Next
	Mouse
	Click the Skip to Next button

	Keyboard
	Press Alt+S
	OR tab to the Skip to Next button and press Enter


	Cancel
	Mouse
	Click the Cancel button

	Keyboard
	Press the Escape key





	DocuPower Pro™ Tool Kit
	What’s In The Tool Kit?
	Close All Open Files
	Display Date On Menu
	Exit Windows Now!
	List All Files in Directory...
	Restart Windows
	Run Program (Command Line)
	Windows System Status (Metz)

	Running the Tool Kit
	From The “Tools” Menu
	Mouse
	Choose the DocuPower Pro — Tool Kit item from the "Tools" menu

	Keyboard
	Press Alt+O, K


	From The Docupower Pro™ Window
	Mouse
	Choose the Open DocuPower Folders menu item from the "File" menu

	Keyboard
	Press Alt+Shift+D

	Mouse
	Click the Tool Kit button

	Keyboard
	Press Alt+T
	OR tab to the Tool Kit button and press Enter


	The Tool Kit Window
	The Run Button
	Mouse
	Click the Run button

	Keyboard
	Press Alt+R
	OR press Enter


	The Folders Button
	Mouse
	Click the Folders button

	Keyboard
	Press Alt+F
	OR tab to the Folders button and press Enter


	Cancel
	Mouse
	Click the Cancel button

	Keyboard
	Press the Escape key




	Additional Tool Kits
	Font Minder
	Text Jumper
	BookMark Lister
	Edit Templates
	Open Most Recent Files
	Print All Open Files
	WinWord INI Changer
	How To Order
	Price
	Special Offer
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